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Abstract: 

IoT-based smart solar vacuum cleaner is a new sustainable solution for cleaning solar panels and 

optimizing energy consumption. As solar power continues to grow as a renewable energy source, solar 

panel maintenance and efficiency have become increasingly important. Dust, debris and other 

contaminants can accumulate on the solar panel, resulting in reduced efficiency and power. Traditional 

cleaning methods are expensive, time consuming and often impractical, especially for large solar 

installations. This research presents a new method for solar panel cleaning using a solar powered IoT 

vacuum. 

 

The system consists of the following main components: 

Solar Vacuum Cleaner Unit: This cleaning machine consists of a brush and a vacuum cleaner specially 

designed to gently remove dust and debris from the solar panel without damaging it. Solar Panel 

Monitoring System: Integrated sensors continuously monitor the cleanliness and functionality of solar 

panels. The data is sent to a central control center for analysis. IoT Network: Wireless communication 

connects solar vacuum cleaner an central control center for real-time data exchange and remote control. 

Central Control Unit: This unit acts as the brain of the body, processing information from monitoring 

sensors and making intelligent decisions. It uses machine learning algorithms to predict the optimal 

cleaning time for each panel. Solar power and batteries: Solar powered vacuum cleaners are solar 

powered and self powered. It is also equipped with a storage battery that guarantees uninterrupted 

operation even on cloudy days or at night. 

 

INTRODUCTION: 

Cleaning is an important business almost everywhere. This is sometimes easy, sometimes difficult. 

Sometimes we hire and pay people to clean sometimes we have to clean in areas where 's life is at risk, 

so we can't bring all to life. It takes more than one person to clear so we need some tools to do . As 

science progresses, robots appear, tab but in they were run by humans.We need more than technologies 

to avoid these manpower limitations. Automation solves this problem well. That's why we built the 

autonomous floor cleaning robot. Because the ultrasonic sensor acts as the eye of the robot, the 

ultrasonic sensor is the most important part of the autonomous floor cleaning robot. The ultrasonic 
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sensor can be used to turn the robot by detecting obstacles or walls.The measured distance is set by 

programming. In most cases, the robot hears the issue and returns. Cleaning is an important business 

everywhere. This is sometimes easy, sometimes difficult. Sometimes we have people clean and pay cash 

for reasons, sometimes we have to clean in areas where lives are at risk, so we can't change lives 

anywhere.There are few places with large areas to protect the because we need more than one person 

so we need to find a way to get the to fix these problems. Robots are appearing in science education, but 

are employed by teachers. We need more innovation to break the limitations of teachers. 

Computerization is an unusual solution to this problem. So we created a vacuum cleaner robot that 

works with IoT and Arduino programming.Today's families are getting smarter and more technological. 

one. Building robots at home provides help and creates more opportunities for humans. 

Home robots enter homes and the lives of people every day, but this is still a new and immature market. 

 

MOBILE INDUSRTIAL ROBOTS: 

Mobile industrial robots, also known as autonomous mobile robots (AMRs), are advanced robotic 

systems designed to automate material handling and transportation tasks within industrial environments. 

They are equipped with sensors, onboard computing capabilities, and sophisticated navigation systems 

that allow them to operate autonomously without the need for human intervention or infrastructure 

modifications. 

Here are some key characteristics and features of mobile industrial robots: 

1. Navigation: Mobile industrial robots use a combination of sensors, such as lasers, cameras, and lidar, 

to perceive their surroundings and navigate through the workspace. They can detect obstacles, map 

the environment, and plan optimal paths to reach their destinations. 

2. Autonomy: These robots operate autonomously, meaning they can make decisions on their own and 

adapt to dynamic environments. They can handle tasks such as picking up and delivering items, 

transporting materials, and collaborating with humans or other robots. 

3. Flexibility: Mobile industrial robots are highly versatile and can be easily deployed in various 

industrial settings, including warehouses, factories, fulfillment centers, and distribution centers. They 

can navigate around obstacles, move between different workstations, and work alongside human 

workers. 

4. Safety: Safety is a crucial aspect of mobile industrial robots. They are equipped with built-in safety 

features, such as collision avoidance systems, emergency stop buttons, and sensors to detect and 

respond to human presence. These measures ensure the safety of both the robots and the humans 

working in their proximity. 

 

EXISTING SYSTEM: 

INTRODUCTION: 

In the current system, an object search method based on global images based on contour elastic 

matching is proposed. This paper does many different tests. The authors concluded that dustmap 

shortens the cleanup time, as it reduces the time required to clean the same area multiple times. 

Interference in the chamber increases the time and energy consumed by the as the vacuum needs to be 

changed more frequently. 
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EXISTING SYSTEM: 

 The researchers used the design method as they intended to talk more with client software through 

meanwhile he will (partially) learn more in layout In summary, the developer prioritizes meeting the 

needs of the purchasing machine throughout the process. The first "customer rest" bulletin and 

improvement in that is, at the level of "build / update model" immediately after the needs of the buyers, 

especially as a finished product to complete the design and preparation special. from "research driver 

model" level to . We already have as a hobby, see what software the buyer needs, or whether the needs 

more than machine software, that's what was designed for, if less needed go to real . 

 

EXISTING SYSTEM BLOCK  DIAGRAM: 

 
DISADVANTAGES: 

• Existing system has some limitations due to atmospheric conditions. 

•  Also had limitation of high false alarm rate. 

• System was installation of too many antennas; 

• Continuous power was required to both WSN sensor setup and antennas. 

• In addition to this climatic/seasonal changes can affect the system 

 

PROPOSED SYSTEM: 

INTRODUCTION: 

 Cleaning is important business almost everywhere. This is sometimes easy, sometimes difficult. 

Sometimes we have people do the cleaning of and pay for it, sometimes we have to clean in areas where 

the life of is in danger, so we can't give life to all. 

 

PROPOSED SYSTEM: 

First check if it is in book mode. If so, check the keyboard. Controls whether a key is pressed on the 

keypad, for example left, right, or middle. If so, then the data of will appear on the LCD, so we use the 

mobile phone as a remote control to manually control the robot. Data is sent to bot . It then checks for 

any problems. If so, show the signal and tell robots to stop and return to manual mode. If there is no 

interference , the robot checks the received signal. If a data signal is received, starts decoding the data 

and displays it on the LCD.  

If the data signal is not received, it returns and checks the data sent to. 
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• We created this project based on the installation of all parts of the robot on the robot and controller 

via wireless devices. 

• If fire is detected, the thermal sensor sends a signal to the processor. 

• Find the fire location according to the displayed directory 

 

PROPOSED SYSTEM BLOCK DIAGRAM: 

 
The concept uses physics and engineering electronics to produce the flame. It is important to understand 

that, according to the physics aspect of the sound wave, the sound wave pattern is known as the 

longitudinal pressure wave - this means that the waves move in a returning vibrational sound and they 

can confuse the wind. molecules move away from the fuel of the flame . Second, we assume that the 

physical aspect of the ideal gas law has an effect on the flame. The ideal gas law states that the time 

pressure volume of the gas is equal to n, the product of, and the constant R, the universal gas 

temperature time (PV = nRT). Therefore, when the pressure wave is directed to the surface of the flame, 

it lowers the pressure of the surface, which in turn lowers the temperature of the flame. 

Ultrasonic sensors are used to detect obstacles in this system. The frequency of the sound wave emitted 

by the ultrasonic sensor is the ultrasonic spectrum (20KHZ), which the human ear cannot hear. The 

sound waves hit the barrier and returned to the detector. Ultrasonic sensors are used to detect 

objects/obstacles and move them in the robot direction. Blind calls the mobile phone number registered 

in the microcontroller with in an emergency using the GSM module. Robot movement will be controlled 

using GSM technology. And the uses ultrasonic obstacle avoidance to achieve this. Here is an Arduino 

Uno used as a microcontroller. The circuit consists of a GSM module, an ultrasonic sensor, two L293D 

driver ICs, two motors, a vacuum cleaner and an LCD screen. The ultrasonic sensor trigger and echo 

pins are respectively connected to the PWM on the Arduino. The virtual terminal represents the GSM 

module. RXD and TXD of GSM module are connected to TXD and RXD of Arduino. A motor driver IC 

(L293D) is used to drive the. The connection between the two motors is to drive the motor  

• IN1 and IN2 of are connected to motor  

• Connects to L293D engine. power 1, OUT3 and OUT4 are connected to motor  

• LCD interface is LCD RS, E, D4-D7 connection. 
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ADVANTAGES: 

• This technology is used to construct an efficient and intelligent dynamic evacuation path. 

• Reduce casualties and economic losses. 

 

SYSTEM REQUIREMENTS: 

HARDWARE REQUIREMENT: 

• Arduino NANO 

• Ultrasonic Sensor 

• Vacuum Pump 

• Solar Panel 

• Battery 

• Robot Mechanism 

 

SOFTWARE REQUIREMENTS: 

• Arduino IDE 

 

POWER SUPPLY: 

A Power Supply Unit (sometimes called a Power Supply Unit or PSU) is adevice or system that supplies

 electrical power or other power to the Loadoutput or load bank products.The term is usually used for ele

ctrical equipmentis rarely used for mechanical equipment and rarely for other equipment. 

 
Block diagram of power supply 

This circuit is a small +5V power supply which is useful when doing digital experiments with the. 

Small,inexpensive wall transformers with to change output voltages can be purchased from all 

electronics stores and supermarkets. Transformers are simple, but often have poor regulation, making 

them of little use in electrical testers unless a good control of the accomplishes anything. The answer to 

question is below. 

 

TRANSFORMER: 

A transformer is a device that converts electricity from one circuit to another through inductive coupling.  

A change in current in the primary circuit (primary) causes the magnetic field to change; in turn, this 

magnetic field causes a change in voltage in the secondary circuit (secondary). When a load is added to 

the second circuit, current will flow in the transformer so changes energy from one circuit to another. 
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The second induced voltage VS is measured from the first VP, which is equal to the ratio of the number 

of turns in different windings: 

 
With the right choice, the transformer will allow to increase the AC voltage by making NS greater than 

NP, or to lower by making it smaller. Transformers are some of the most efficient electrical "machines", 

some large units are capable of converting 99.75% of input power into output. Transformers come in a 

variety oftransformers hidden in stage microphones to huge gigaamp-rated units used to cut parts of the 

national grid. Although there are many models designed for specific home and business tasks, they all 

work on the same principle. 

  
An ideal step-down transformer 

A simple ideal step-down transformer design is shown in figure above. Now create a magnetic field in 

the first step. primary and secondary coils are wound on iron core with high permeability, such as iron 

core; this ensures that most of the magnetic field is generated by the primary current in the wire and goes 

through the secondary coil. like the first coil. 

 

RECTIFIER: 

A rectifier is an electrical device that converts alternating current (AC) to direct current (DC) that flows 

in only one direction. This process is called correction. The rectifier is used as a component of electronic 

equipment and a receiver of the radio signal. There are three rectifiers. Half wave rectifiers, full wave 

rectifiers and bridge rectifiers. 

 

Bridge Rectifier: 

A diode bridge is an arrangement of four (or more) diodes in a bridge circuit configuration that provides 

an output in the same polarity and an input in both polarities. In its most common application, the is 

known as a bridge rectifier as it converts a direct current (AC) input to a direct current (DC) output. The 

bridge  from a 2-wire AC input to a 3-wire input with a central tapped secondary winding transformer. 

The basic feature of the diode bridge is that whatever the polarity of the input to the is, the polarity of the 

output is the same. 
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Basic operation: 

In the figure below, when the input connected to the left side of diamond is positive and the input 

connected to the right side is negative, current flows from the supply using the upper part as the red 

(good) path on the right. Take exit and take the blue (negative) road back to the lower transport area. 

 
Current flow of bridge rectifier 

When the left corner connected input is negative and the right connected input is positive, current flows 

from the low voltage terminal along the right side red (good) path to the output and back to the upper 

power. take the blue (negative) route to the terminal at. In all cases, the upper right output is positive and 

the right output is negative. Since this is true regardless of whether the input is AC or DC, instead of the 

producing only DC from the AC input, this circuit also gives the what is sometimes referred to as 

"reverse polarity protection". That is, when the battery returns toor the leads (wires) of the DC power 

supply return to , it allows DC power tools to work properly and protects the device from damage caused 

by reverse polarity. 

 

IC Voltage Regulators: 

Voltage regulators include a commonly used class of ICs. Regulator IC Unit includes power supply, 

comparator, controller, and overload protection in a single IC. While the internal structure of the IC is 

slightly different from the different voltage regulators described, the external operation of the is the 

same. IC unit provides regulation of constant positive voltage, constant negative voltage or adjustable set 

voltage. The power supply can be produced using a transformer connected to the AC power line to step 

up the AC voltage to the desired level, then adjust the AC voltage, filter the with capacitors and RC 

filters if necessary, and finally control the DC voltage . Using IC voltage regulator. The voltage 

regulator can select an operating current from hundreds of milliamps to tens of amps, corresponding to a 

power rating of from milliwatts to tens of watts. 

 

Three-Terminal Voltage Regulators: 

 
Basic connection of a three-prong regulator IC to a load. The Constant Voltage Regulator has a constant 

DC input voltage (Vi) applied to an input terminal , controlling the output DC voltage (Vo) from the 

second terminal and the third of the to ground. For an optional controller, IC device specification 

specifies a range within which the input voltage can vary, and provides a fixed output voltage over a 

range of input currents. The specification also specifies the amount of output voltage change due to 
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changes in load current (load regulation) or input voltage (line regulation). 78 Series Voltage Regulators 

provide stable voltage regulation from 5 to 24 V. The schematic shows how the IC is connected to the 

+5V DC output of the unit of the 7805 to provide voltage control. The unregulated input voltage V is 

filtered by the capacitor C1 and is connected to the IN terminal of the IC. The IC's OUT terminal 

provides a regulated + 12V voltage filtered (for noise only) by capacitor C2. Third IC terminal grounded 

(GND). When the input voltage can vary within some range of output voltage, and the output load can 

vary within some range, the output voltage remains constant within the voltage change limit.These 

parameters are specified in the manufacturer's specification sheet. 

 

ULTRASONIC SENSOR: 

 
Ultrasonic sensors 

Ultrasonic sensors are based on measuring equipment of sound parameters with frequencies above the 

human audible range. They follow three physical principles: time of flight, Doppler effect, and sound 

wave attenuation. The Ultrasonic Sensors do not interfere as they do not need physical contact with their 

targets and can detect some clear or bright targets that would otherwise interact with the for some that 

don't look like sensors. On the other hand, its measurements are sensitive to temperature and target. 

ultrasonic sensor "According to the measurement of the acoustic energy of at frequencies above the 

human audible range",(40 kHz 1), respectively. 

They usually work by generating reverb pulses and then taking and measuring the characteristics of the 

reverb pulses. The can measure three different echo pulses received for different targets. 

 

Modes of Operation: 

Reflection Mode: 

The pulse bounces off a target and returns to the receiver after a time interval t. The receiver records the 

length of this time interval, and calculates the distance travelled r based on the speed of sound c. 

 
Working model 

Often, separate transmit and receive transducers are placed side by side in a room. (PING) Range Finder, 

Omega flowmeter and Migatron high precision sensor below are all design. then the distance from the 
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sensor to the target will be twice the distance. With proper coordination, a switch can be used to send 

pulses and receive echoes. Note that it takes time for the transducer to change the die, making it difficult 

to measure closely. 

 

Direct Measurement Mode: 

In this mode of operation, the transmitter and receiver are two separate units moving towards each other. 

For example, the receiver may be fixed to a moving destination to a fixed delivery location, and vice 

versa. The may use multiple emitters to increase the direction of the propagating pulses. Lima et al. 

Several ultrasonic transmitters are placed on the Performer, whose signals are received by several 

receivers in the Performance area, allowing a computer program to triangulate the Performer's position. 

 

SOFTWARE DESCRIPTION: 

Arduino is open source, electronics based, easy to use hardware and software. Arduino boards can read 

the input - light from the sensor, finger on the button, or Twitter message - and convert that to an output 

- activate the motor, turn on the LED, post something online. You can tell your board what to do by 

sending instructions to the microcontroller on the board. For you can use Arduino programming 

language (wiring based) and follow Arduino software (IDE). The Arduino has been at the center of 

thousands of projects over the years, from everyday tools to complex research tools. A global 

community of creators - students, amateurs, artists, professionals and professionals - gathered around the 

open platform and contributing an incredible useful information whose contributions should be valued 

can be of great help to novices and novices alike. experts liked it. The Arduino was born by the Ivrea 

Interaction Design Institute as a simple tool for rapid design, for students without electronics and 

programming background. Once the Arduino board reached the wider community, the began evolving to 

meet new needs and challenges, differentiating its use from the as a simple 8-bit board for use in IoT 

applications, wearables, 3D printing, and embedded environment. . All Arduino boards are fully open 

source and the allows users to create their own boards and ultimately adapt them to their specific needs . 

The software is also open source and continues to grow with the participation of users worldwide. 

 

Inexpensive - Arduino boards are relatively inexpensive compared to other microcontroller platforms. 

The cheapest version of the Arduino module can be assembled by hand even before the Arduino module 

comes in for less than $50. 

 

Cross-platform - Arduino software (IDE) runs on Windows, Macintosh OSX and Linux operating 

systems. Most microcontroller systems are, Windows only. 

 

Simple, clear programming environment -  The Arduino Software (IDE) is easy for beginners, but 

flexible enough for advanced users to take advantage of the. It is as easy for teachers as the operating 

environment, so students learning in the environment will know how the Arduino IDE works. 

 

Open source and extensible software -  Arduino software released as an open source tool that can be 

extended by experienced programmers. The language can be extended with the C++ library, and anyone 

who wants to understand the content of can switch from Arduino to the AVR C programming language 

on which it is based. Similarly, you can add AVR-C code directly to your Arduino program if you want. 
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Open source and extensible hardware - The plans for the Arduino board have been released under the 

Creative Commons license, so programmers familiar with the can make, expand and develop their own 

version of the module. Even users unfamiliar with the can create a breadboard model of the to see how it 

works and save money. 

 

ARDUINO SOFTWARE (IDE): 

The Arduino Integrated Development Environment - or Arduino Software (IDE) - includes a text box for 

writing code, a text field, a text console, a toolbar with buttons for actions, and more menu items. It 

connects to the Arduino hardware to upload programs and communicate with them. 

 
 

Writing Sketches: 

Programs written using Arduino software (IDE) are called sketches. sketches are written as text and 

saved with the .ino file extension. Editor has text cut/paste and search/replace features. When saving and 

exporting, the message field has comments and an error will occur. The console displays the output of 

the Arduino software (IDE), including the completion error message and other information. The lower 

corner of the window shows the board configuration and serial port. Toolbar button allows you to define 

and load programs, create, open and save drawings, and open monitors. 

• Verify Checks your code for errors compiling it. 

• Upload Write your code and upload it to the installer board. See the download below for details. 

NOTE: If you are using an external programmer on the board, you can press and hold the "shift" key 

on the computer while using this symbol. The text will change to "Install using Programmer". 

• New Creates a new sketch. 

• Open Put a menu on each drawing in Sketchbook. When is clicked, it opens in the current window 

and its contents are saved. 

• Save Saves your sketch. 

•  Serial Monitor Opens the serial monitor. 
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Arduino IDE Tool Icon 

 

Additional commands can be found in five menus: File, Edit, Sketch, Tools, Help. The menu is 

contextual, meaning only items related to the task in progress are displayed. 

 

Boards: 

The clipboard chooses to do two things: set the parameters used when compiling and uploading the 

sketch (like CPU speed and baud rate); and lists the file and fuse settings used by the burn bootloader 

command. The contents of some boards differ only in the latter, so even if you successfully installed 

with custom options, you still need to check before writing the bootloader. The Arduino software (IDE) 

includes built-in support for the boards listed below, all based on the AVR core. 

 

Started with the Arduino: 

Arduino Nano is a small, complete, breadboard friendly board based on the ATmega328P. It has the 

same connections and features as the UNO board in a smaller form factor. 

 
Arduino NANO Interface 

The Arduino Nano is programmed using the Arduino Software (IDE), our Integrated Development 

Environment for all our boards and can run the online and offline. For more information on how to get 

started with the Arduino software, visit the Getting Started page. 

 

Open your first sketch: 

Open the LED blink example sketch: File > Examples > 01.Basics > Blink. Select Tools > Board > 

Arduino AVR Boards > Arduino Nano. 

Note: We updated the nano board with a brand new bootloader. The motherboards we've sold since 

January 2018 have the new bootloader, while the boards produced before that date have the old 

bootloader. First, check Tools > Board > Board Manager to see if Arduino AVR Boards 1.16.21 or is 

https://www.ijfmr.com/
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installed. Next, you need to select Tools>Processor>ATmega328P in to work on the new Arduino 

NANO board. To work on legacy board you need to select Tools > System > ATmega328P (Legacy 

Bootloader). If you encounter error during installation or are unsure of which bootloader you are using, 

try everything from the Tools > Processor menu until your board is programmed. 

 
Picture of select the NANO Processor Type 

Select the Serial Port tool from the Serial Port Tools menu. This is probably COM3 or later (COM1 and 

COM2 are usually reserved for hardware serial ports). You can cut the board and reopen menu to find 

out; the missing input must be Arduino board. Reconnect board and select serial port. 

 
Picture of Select Board Type 

 

Upload and Run your first Sketch: 

To upload the sketch to the Arduino Nano, click the Upload button in the upper left to load and run the 

sketch on your board: 

 
Picture of upload to Nano 

Wait a few seconds - you should see the  RX and TX LEDs on the board blink. If the installation is 

complete, the message "Installation complete" is displayed. will appear in the status bar.  

https://www.ijfmr.com/


 

International Journal for Multidisciplinary Research (IJFMR) 
 

E-ISSN: 2582-2160   ●   Website: www.ijfmr.com       ●   Email: editor@ijfmr.com 

 

IJFMR23044840 Volume 5, Issue 4, July-August 2023 13 

 

RESULT AND DISCUSSION: 

First check if it is in book mode. If so, check the keyboard. Controls whether a key is pressed on the 

keypad, for example left, right, or middle. If yes, information is displayed on the LCD accordingly. Our 

phone number is and it is used to manually control the robot remotely. The information is sent to the 

robot. will then check to see if any problems are found. If yes, show the signal and tell the robot to stop 

and return to manual mode. If there is no interference, the robot checks the received data signal. If a data 

signal is received, starts decoding the data and    displays it on the LCD. If the data signal is not 

received, it returns and checks the sent data. 

• Battery Capacity - 12V -10 Ah 

• Panel Capacity 9V- 7 Watts 

• Vaccum Suction Force - 3500 PA 

• Suction Patricel Size and Weight- 80-100gsm 

 

BATTERY CHARGING TIME: 

• Through Panel - 4 hrs 

• Through DC Supply - 2hrs 

 
Charging 

 
 

Discharging 

The frequency of the sound wave emitted by the ultrasonic sensor is in the ultrasonic frequency 

spectrum (20KHZ), which the human ear cannot hear. The sound wave hit the barrier and returned to the 

detector. Ultrasonic sensors are used to detect objects/obstacles and move the robot's direction. Blinds 
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uses the GSM module to call the mobile phone number registered in the microcontroller in an 

emergency and calls. The movement of the robot will be controlled using GSM technology. And the 

uses ultrasonic obstacle avoidance to achieve this. 

 

CONCLUSION: 

The Solar Panel Maintenance System project aims to bring better solutions to sustain solar power. The 

main task is to create a machine that can clean the solar panel with the appropriate control. This project 

has to learn design control, python coding to build and interacts with electronic equipment. Use the 

boards to learn how to design the circuit, the hardware blocks, relays and mechanics are all new. says so, 

the project completes the plan established by the administrative management and mechanism. The DC 

motor is controlled by relays and drivers, and the does the speed and control. In addition, control rules 

for DC motor and pump were written and entered into the system. Overall, the design and improvisation 

of the sonic fire extinguisher is complete. All extinguishers must be made for the to function properly. 

The sonic fire extinguisher with these modifications will complement the new safety and firefighting and 

rescue. According to the test of, it is seen that the sound wave can extinguish the flame. 

 

PROGRAM: 

//Header File 

#include<Wire.h> 

#include <SoftwareSerial.h> 

SoftwareSerial myStream(2, 3); //pins for Rx and Tx respectively 

//Temperature Sensor Define I/O 

const int analogtemp = A2; // This is the analog pin which is measuring the input 

voltage from the LM35 temperature sensor 

double temp=0, Vin=0, samples[250]; 

unsigned int j=0; 

const double Vref=1100.0; 

//Define I/O 

int gasPin = A3; // Gas Input Pin 

float sen_vol = 0; 

float sen_val = 0; 

//L293D 

//Left Motor A 

const int L1 = 2; // Pin 14 of L293 

const int L2 = 3; // Pin 10 of L293 

//Right Motor B 

const int R1 = 4; // Pin 7 of L293 

const int R2 = 5; // Pin 2 of L293 

nt incomingByte = 0; 

// Ultrasonic pins numbers 

const int trigPin = A0; 

const int echoPin = A1; 

// defines variables 
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long duration; 

int distanceCm; 

int fir = A2; 

int fire= 0; 

int sp = 0; 

int spk = 9; 

//Main program 

void setup() 

{ 

//Sensor Input 

pinMode(fir, INPUT); 

pinMode(spk, OUTPUT); 

//L293D Output 

pinMode(L1, OUTPUT); 

pinMode(L2, OUTPUT); 

pinMode(R1, OUTPUT); 

pinMode(R2, OUTPUT); 

//Ultrasonic Pin 

pinMode(trigPin, OUTPUT); // Sets the trigPin as an Output 

pinMode(echoPin, INPUT); // Sets the echoPin as an Input 

Serial.begin(9600); 

delay(1000); 

} 

//Loop program 

void loop() 

{ 

//Ultrasonic Sensor 

digitalWrite(trigPin, LOW); 

delayMicroseconds(2); 

digitalWrite(trigPin, HIGH); 

delayMicroseconds(10); 

digitalWrite(trigPin, LOW); 

duration = pulseIn(echoPin, HIGH); 

distanceCm= duration*0.034/2; 

//distanceInch = duration*0.0133/2; 

fire = digitalRead(fir); 

if(distanceCm < 8) 

{ 

digitalWrite(L1, LOW); // control for stop 

digitalWrite(L2, LOW); 

digitalWrite(R1, LOW); 

digitalWrite(R2, LOW); 

Serial.println("OB Stop\n"); 
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} 

serialmotor(); 

if(sp ==1){ 

while(1){ 

digitalWrite(spk , HIGH); 

delay(50); 

digitalWrite(spk , LOW); 

delay(50); 

serialmotor(); 

if(sp == 0){ 

digitalWrite(spk , LOW); 

return; 

} 

} 

} 

else{ 

digitalWrite(spk, LOW); 

} 

Serial.println(); 

delay(500); 

} 

void serialmotor() 

{ 

if (Serial.available() > 0) 

{ 

incomingByte = Serial.read(); 

} 

switch(incomingByte) 

{ 

case '1': 

digitalWrite(L1, LOW); // control for stop 

digitalWrite(L2, LOW); 

digitalWrite(R1, LOW); 

digitalWrite(R2, LOW); 

Serial.println("Stop\n"); 

incomingByte='*'; 

break; 

case '4': 

digitalWrite(L1, HIGH); // control for right 

digitalWrite(L2, LOW); 

digitalWrite(R1, HIGH); 

digitalWrite(R2, LOW); 

Serial.println("Right\n"); 
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incomingByte='*'; 

break; 

case '3': 

digitalWrite(L1, LOW); // control for left 

digitalWrite(L2, HIGH); 

digitalWrite(R1, LOW); 

digitalWrite(R2, HIGH); 

Serial.println("Left\n"); 

incomingByte='*'; 

break; 

case '2': 

digitalWrite(L1, HIGH); // control for forward 

digitalWrite(L2, LOW); 

digitalWrite(R1, LOW); 

digitalWrite(R2, HIGH); 

Serial.println("Back\n"); 

incomingByte='*'; 

break; 

case '5': 

digitalWrite(L1, LOW); // control for backward 

digitalWrite(L2, HIGH); 

digitalWrite(R1, HIGH); 

digitalWrite(R2, LOW); 

Serial.println("Forward\n"); 

incomingByte='*'; 

break; 

case '6': 

sp = 1; 

Serial.println("S ON\n"); 

incomingByte='*'; 

break; 

case '7': 

sp = 0; 

Serial.println("S OFF\n"); 

incomingByte='*'; 

break; 

} 

} 
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